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NÂNG CAO ĐỘ CHÍNH XÁC TRONG ĐÁNH GIÁ ỨNG SUẤT DƯ 

VÀ MẬT ĐỘ VẾT NỨT TẾ VI CỦA LỚP PHỦ 

 Nguyễn Vĩnh Phối1 

TÓM TẮT 

Hiện nay, mạ phủ là một trong những công nghệ tiên tiến được nghiên cứu để áp 

dụng vào công nghệ xử lý bề mặt. Do đó, các phương pháp để đánh giá các tính chất của 

lớp phủ được chú trọng nghiên cứu. Trong bài báo này, công thức tính sai số cho 

phương pháp đo ứng suất dư của lớp phủ dùng nhiễu xạ tia X được xây dựng. Phương 

pháp đánh giá mật độ vết nứt tế vi của lớp phủ dùng công nghệ xử lý ảnh cũng được phát 

triển. Kết quả nghiên cứu thực nghiệm cho thấy, sai số ứng suất của lớp phủ được tính 

toán ứng với phương pháp nội suy đường nhiễu xạ tia X dùng phương trình Gauss. Mật 

độ vết nứt tế vi được đánh giá chính xác qua công nghệ xử lý ảnh.  

 Từ khóa: Phun phủ, mạ crôm, ứng suất, mật độ vết nứt tế vi, tia X. 

1. Đặt vấn đề 

Hiện nay, phương pháp mạ phủ đã và đang được nghiên cứu và ứng dụng rộng rãi 

trong công nghiệp, đặc biệt là trong ngành: ôtô, hàng không, thực phẩm, hóa dầu,... Mạ phủ 

là phương pháp để tạo lớp bề mặt với các tính chất cơ học, ma sát, chống mài mòn, ăn mòn 

hóa học tốt hơn hẳn vật liệu nền ban đầu. Ngoài tăng bền cho bề mặt chi tiết với tính chất 

chống mài mòn, ăn mòn tốt, độ cứng cao... mạ phủ còn được sử dụng để phục hồi các chi 

tiết máy bị mài mòn như chi tiết trục, khuôn đúc... Với những tính chất ưu việt đó, công 

nghệ mạ phủ đã có những bước phát triển mạnh mẽ và nhận được quan tâm nghiên cứu 

rộng rãi của các nhà khoa học. 

Trong ngành cơ khí, phương pháp mạ điện đã và đang được áp dụng rộng rãi do 

những tính năng và ứng dụng vượt trội của nó. Trong các vật liệu mạ: kẽm, đồng, niken, 

titan... mạ crôm được sử dụng nhiều nhất. Lớp mạ phủ crôm làm tăng độ cứng bề mặt, 

giảm ma sát, chống mài mòn cho các chi tiết. Ngoài ra, bề mặt chi tiết được mạ crôm được 

bao phủ bởi một lớp màng mỏng ôxít crôm Cr2O3, nên có ánh bạc, khả năng chống trầy 

xước cao và chống ăn mòn tốt. Akktar và các cộng sự [1] nghiên cứu ảnh hưởng của lớp 

phủ crôm đến cơ tính của thép SAE 4140. Kết quả nghiên cứu cho thấy chi tiết được phủ 

crôm có tính chống ăn mòn rất tốt do hình thành lớp ôxít crôm trên bề mặt. Lớp phủ 

crôm có độ cứng chống mài mòn cao cũng được Detao và các cộng sự [2] đánh giá. 

Arieta và các DT Gawne [3] nghiên cứu độ bền và khả năng thấm ướt của lớp phủ crôm. 

Kết quả nghiên cứu cho thấy chi tiết được phủ crôm có độ bền cao và lớp phủ crôm tồn 

tại vết nứt tế vi nên có thể chứa màng chất lỏng làm tăng khả năng bôi trơn.  

Trong các tính chất của lớp phủ crôm, ứng suất dư và mật độ vết nứt tế vi là hai 

yếu tố quan trọng. Vì vậy, nhiều công trình nghiên cứu đã được thực hiện để đánh giá hai 

thông số này. Gawne [4] nghiên cứu phá hủy trong lớp phủ crôm và kết quả nghiên cứu 

cho thấy trong lớp phủ crôm có xuất hiện phân hủy crôm hydrua trong quá trình kết tủa 
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crôm gây co rút thể tích, làm phát sinh ứng suất kéo và ảnh hưởng xấu đến tính chất cơ 

học của chi tiết. Để đánh giá ứng suất trong lớp phủ, các nghiên cứu sử dụng phương 

pháp nhiễu xạ tia X và đều cho thấy trong lớp phủ crôm luôn tồn tại ứng suất dư kéo [5-

7]. Về mặt kỹ thuật đo, đây là phương pháp đo không tiếp xúc và chính xác. Tuy nhiên, 

hầu hết các nghiên cứu đều không tính sai số của phương pháp đo. Chỉ số ít công trình có 

đề cập đến độ chính xác của phép đo nhưng không trình bày cụ thể phương pháp xác 

định sai số này [8].  

Ngoài ứng suất dư, mật độ vết nứt tế vi là một thông số của lớp mạ crôm, nguyên 

nhân là quá trình phân hủy crôm hydrua làm phát sinh ứng suất kéo và gây ra nứt mạng 

tinh thể. Pina [5] và các cộng sự nghiên cứu cấu trúc tế vi của lớp phủ crôm. Kết quả 

nghiên cứu cho thấy lớp phủ crôm có nhiều vết nứt và được đánh giá cảm quan qua ảnh 

kính hiển vi quang học. Vết nứt tế vi cũng được đánh giá cảm quan qua ảnh kính hiển vi 

điện tử quét SEM (Scanning Electron Microscope) [7, 9]. Nascimento [10] và các cộng 

sự đã đề xuất một phương pháp đo định lượng mật độ vết nứt lớp phủ crôm. Vết nứt 

được đánh giá bằng cách kẻ các đường ngang trên ảnh chụp bằng kính hiển vi quang học 

và đếm các điểm giao nhau giữa các vết nứt với các đường thẳng này. Mật độ vết nứt 

được xác định với tỷ lệ các điểm giao nhau cho chiều dài đường ngang. Tuy nhiên, 

phương pháp này cho độ chính xác không cao. Vidal [11] và các cộng sự nghiên cứu 

phương pháp đánh giá mật độ vết nứt tế vi dựa trên hình ảnh SEM. Nhóm tác giả đã nhị 

phân hóa và xử lý ảnh SEM với thuật toán đạo hàm bậc hai khi dùng phương pháp LoG 

(Laplacian of Gaussian). Phần mềm Matlab được sử dụng để xử lý ảnh. Tuy nhiên, thuật 

toán này khá phức tạp. 

Trong nghiên cứu này, công thức đánh giá sai số khi tính sai số ứng suất cho lớp 

phủ nói chung và phương pháp mạ crôm nói riêng khi dùng nhiễu xạ tia X được xây 

dựng. Bên cạnh đó, một phương pháp đơn giản hóa việc đánh giá mật độ vết nứt tế vi của 

lớp phủ sử dụng xử lý ảnh qua phần mềm ImageJ cũng được phát triển.  

2. Tổng quan về nhiễu xạ tia x và ứng dụng đo ứng suất   
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Hình 1.  Hệ trục tọa độ dùng trong đo ứng suất  
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Xét hệ tọa độ như Hình 1, trong đó Si là hệ tọa độ gắn liền với mẫu, trong đó S1, S2 

nằm trong mặt mẫu. L3 là hệ tọa độ đo, vuông góc với họ mặt phẳng nguyên tử {hkl}. L2 

nằm trong mặt phẳng mẫu tạo với S1 một góc φ. 

Biến dạng xác định từ biến dạng trong hệ tọa độ đo, nó có thể được biểu diễn thông 

qua biến dạng của hệ tọa độ mẫu bằng hệ thống ma trận chuyển đổi tọa độ. Để xác định 

biến dạng, định luật Bragg được sử dụng. Định luật này biểu thị mối quan hệ giữa góc tia 

nhiễu xạ với bước sóng tia X tới và khoảng cách giữa các mặt phẳng nguyên tử [12]: 

n = 2d(hkl) sin    (1) 

Trong đó, n = 1, 2, 3 . . . được gọi là bậc phản xạ. 

 : bước sóng chùm tia X 

 d(hkl): khoảng cách giữa các mặt nguyên tử. 

 : góc nhiễu xạ. 

 Khi xuất hiện ứng suất trên lớp bề mặt thì khoảng cách d(hkl) giữa các mặt nguyên 

tử sẽ thay đổi (Hình 2). Bằng việc tính toán vị trí đỉnh của đường nhiễu xạ thì biến dạng 

của vật mẫu được xác định thông qua khoảng cách d(hkl). Khi tính được khoảng cách d(hkl) 

giữa các mặt phẳng {hkl} từ vị trí đỉnh nhiễu xạ, giá trị biến dạng dọc trục L3 là: 
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Hình 2. Nhiễu xạ tia X trên bề mặt tinh thể. 

 

Hình 3. Đồ thị d-Sin2ψ 

Phương trình (4) có thể viết lại: 

                   (5) 

Đây là phương trình thể hiện mối quan hệ dψ - sin2ψ (Hình 3) có hệ số góc m :  

               

Từ phương trình trên ứng suất dư có thể xác định thông qua hệ số góc m: 

         (6) 

3. Phát triển phương pháp nâng cao độ chính xác trong đo ứng suất và mật độ vết 

nứt tế vi của lớp phủ 

3.1. Xây dựng công thức tính sai số trong đo ứng suất dư dùng nhiễu xạ tia X 

 Sau khi có dữ liệu nhiễu xạ, có thể dùng nhiều phương pháp để xấp xỉ đường nhiễu 

xạ để tìm ra đỉnh nhiễu xạ, từ đó tính được khoảng cách d giữa các mặt nguyên tử. Trong 

đó, xấp xỉ đường nhiễu xạ với hàm Gauss cho độ chính xác cao và sai số thấp nhất vì 

hàm Gauss mang tính thống kê và có độ tin cậy cao. Do vậy, tác giả sẽ thành lập công 

thức tính toán sai số khi tính toán ứng suất dư từ giá trị nhiễu xạ khi áp dụng hàm Gauss. 

Ứng suất dư của mẫu được tính dựa trên phương trình d-sin2ψ. Do vậy, khi đo ứng 

suất dư sẽ có sai số, vì các cặp số (sin2ψ1, d1), (sin2ψ2, d2),… (sin2ψn, dn) nhận được từ 

thực nghiệm chỉ là những giá trị gần đúng của sin2ψ, nên chúng không hoàn toàn là 

nghiệm đúng của phương trình d = m. sin2ψ + n. Vì vậy, ta phải xác định sai số trong quá 

trình tính toán ứng suất, nghĩa là: 

d1 – m sin2ψ1– n = v1 

d2 – m sin2ψ2 – n= v2 

……………….. 

dn – m sin2ψn – n = vn 

( )2

0 0 11 22 0

1
sin

v v
d d d d

E E
    

+
= − + +

0

1 v
m d

E


+
=

0

( )
1

m E

d v
 =

+



 TẠP CHÍ KHOA HỌC VÀ CÔNG NGHỆ - SỐ 33 - TRƯỜNG ĐẠI HỌC PHẠM VĂN ĐỒNG 

 

                                                       ⚫ JOURNAL OF SCIENCE AND TECHNOLOGY ⚫    69 

Trong đó các vi là các sai số. 

Ở đây, phương pháp bình phương tối thiểu được sử dụng. Tổng sai phân S được 

xác định là:  
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Vậy m, n phải thỏa các phương trình: 
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Giải phương trình trên ta được: 
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Từ công thức (6) ta có ứng suất có thể viết lại theo tính toán đỉnh nhiễu xạ: 
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Trong đó: σpi là sai số đỉnh nhiễu xạ được xác định qua dữ liệu đo. 

Vậy sai số của ứng suất: 
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=         (11) 

Từ đó 95% tin cậy của giá trị ứng suất được tính toán là: 

           s 96.1=          (12) 

3.2. Phát triển phương pháp đánh giá mật độ vết nứt tế vi dùng công nghệ xử lý ảnh 

ImageJ là một phần mềm xử lý và phân tích hình ảnh mã nguồn mở, miễn phí, 

được phát triển bởi Viện Y tế Quốc gia Hoa Kỳ (National Institutes of Health). Phần 

mềm được viết bằng Java, cho phép chạy trên nhiều hệ điều hành như Linux, macOS, 

Windows…. ImageJ nổi tiếng trong lĩnh vực xử lý ảnh và phân tích hình ảnh. 

 

 

 

 

 

 

 

 

 

 

Việc xác định mật độ vết nứt tế vi được tính thông qua công thức [11]: 

=
Soá ñieåm aûnh maøu ñen

Maät ñoä veát nöùt (%) 100

Toång soá ñieåm aûnh

x

                                

(13) 

Tuy nhiên, ảnh thang độ xám 8 bit có 256 mức cường độ màu khác nhau. Do đó, 

ảnh chụp vết nứt phải được nhị phân hóa, thu gọn 256 mức xuống còn 2 mức, nghĩa là tất 

cả các điểm ảnh (pixel) của vết nứt có màu đen và tất cả điểm ảnh của diện tích nền còn 

lại có màu trắng. Quy trình này được hỗ trợ với phần mềm ImageJ. Sau đó phần mềm sẽ 

đếm số điểm ảnh đen (0) và trắng (255), mật độ vết nứt tế vi tính theo công thức (13). 

Các bước xác định mật độ vết nứt tế vi được thực hiện cụ thể như sau: 

+Bước 1: Sử dụng kính hiển vi quang học để chụp ảnh có vết nứt cần đánh giá. 

+Bước 2: Khởi động phần mềm ImageJ và vào File>Open…để chèn ảnh đã chụp 

+Bước 3: Vào Process>Binary>Options. Đánh dấu vào ô Black Background. Điều 

này nhằm mục đích xác định các điểm ảnh có giá trị 0 sẽ được hiển thị là màu đen và các 

Hình 3. Giao diện phần mềm ImageJ 
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điểm ảnh có giá trị 255 sẽ được hiển thị là màu trắng. Bước này không bắt buộc, nhưng 

để xác nhận quy ước: 255 → trắng, 0 → đen. 

+Bước 4: Vào Image> 8-bit 

+Bước 5: Vào Image>Adjust>Threshold. Đánh dấu vào ô Dark Background. Các 

điểm ảnh sáng hơn sẽ được tô sáng màu đỏ. Các điểm ảnh đỏ này sẽ được ánh xạ thành 

màu trắng (nền) và các điểm ảnh còn lại thành màu đen (vết nứt). Điều chỉnh thanh trượt 

trong hộp thoại đến giá trị tô sáng tất cả (hoặc hầu hết) các điểm ảnh của nền bằng màu 

đỏ. Nhấp vào nút Apply để chuyển sang ảnh nhị phân. 

+Bước 6: Vào Edit>Selection>Create Selection. Thao tác này chỉ chọn các điểm 

ảnh màu trắng (nền). Sau đó, vào Analyze>Measure. Thao tác này sẽ đo lường vùng 

chọn và đưa ra kết quả trong cửa sổ Results. Giá trị tại cột Area là số điểm ảnh màu 

trắng. 

+Bước 7: Vào Edit>Selection>Make Inverse. Thao tác này sẽ đảo ngược vùng 

chọn, thực tế là chọn các điểm ảnh màu đen. Vào Analyze>Measure và thao tác này sẽ 

thêm một hàng kết quả trong cửa sổ Results. Giá trị tại cột Area là số điểm ảnh màu đen. 

Đây là tổng số điểm ảnh vết nứt của ảnh. Từ kết quả trên, mật độ vết nứt tế vi sẽ được 

xác định. 

4. Thực nghiệm và thảo luận 

4.1. Đề xuất chi tiết mẫu 

 Thép C45 được sử dụng rộng rãi trong lĩnh vực cơ khí để chế tạo các chi tiết máy 

chịu mòn, chịu tải trọng tĩnh và va đập tương đối cao như trục, bánh răng, khuôn… Vì 

vậy, vật liệu thép (vật liệu nền) C45 được lựa chọn cho việc chế tạo chi tiết mẫu để tiến 

hành các thí nghiệm trong nghiên cứu này. Thành phần của mẫu thép C45 được đo trên 

máy quang phổ GNR-F20 và thể hiện trên Bảng 1. 

Bảng 1. Các thành phần nguyên tố của thép C45  

Nguyên tố C Si Mn P S Ni Cr  Cu 

Thành phần (%) 0,46 0,21 0,64 0,021 0,007 0,04 0,09 0,16 

 

 

 

 

 

 

 Hình 4. Kích thước mẫu thí nghiệm 
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Để phù hợp với thiết bị mạ và thuận lợi trong quá trình đo ứng suất lớp phủ crôm, 

mẫu thí nghiệm được đề xuất thiết kế, chế tạo như Hình 4. 

Chi tiết mẫu được mạ crôm theo quy trình chuẩn và sử dụng dung dịch mạ chỉ ra ở 

Bảng 2 với các thông số mạ được áp dụng trong công nghiệp hiện nay. 

Bảng 2. Dung dịch mạ và chế độ mạ 

Thành phần dung dịch và chế độ mạ Hàm lượng (g/l) 

CrO3 250 

H2SO4 2.0 

Nồng độ Cr3+ 3 ÷ 6 

Nhiệt độ, 0C 55 

ia (A/dm2) 30 

H (%) 12 

Tỉ lệ CrO3/H2SO4 100/1 

Tỉ lệ diện tích các cực Sa/Sc 1/1 ÷ 2/1 

Tốc độ mạ, μm/ph 0.15 ÷ 0.60 

 

 

 

  

 

 Để đánh giá phương pháp đề xuất, bốn nhóm chiều dày khác nhau của lớp mạ crôm 

được thực nghiệm với chiều dày 10/30/60/90 μm. Chiều dày lớp mạ được đo bằng 

phương pháp dòng điện xoáy ET (Eddy current testing). Sai số của phép đo trên máy 

PosiTector – Defelsko là 1% của giá trị chiều dày thực. Kết quả đo là giá trị trung bình 

sau 5 lần đo tại các vị trí khác nhau trên cùng một mặt phẳng của mẫu. 

Bảng 3. Chiều dày lớp mạ đo bằng phương pháp ET 

Nhóm mẫu Chiều dày lớp mạ (μm) 

1 (10 μm) 9 ± 2 

2 (30 μm) 30 ± 5 

3 (60 μm) 61 ± 7 

4 (90 μm) 93 ± 10 

Hình 5. Mẫu thí nghiệm sau khi mạ crôm 



 TẠP CHÍ KHOA HỌC VÀ CÔNG NGHỆ - SỐ 33 - TRƯỜNG ĐẠI HỌC PHẠM VĂN ĐỒNG 

 

                                                       ⚫ JOURNAL OF SCIENCE AND TECHNOLOGY ⚫    73 

4.2. Tính ứng suất và sai số  

Nhiễu xạ tia X áp dụng phương pháp d-Sin2ψ được sử dụng để tiến hành phân tích 

ứng suất dư trên các mẫu sau khi mạ phủ. Vật liệu crôm có mô-đun đàn hồi E = 271 GPa, 

hệ số Possion υ = 0,23 [13] và phương pháp đo Ψ cố định góc η được sử dụng để tính 

toán ứng suất. 

Mẫu đo được đặt ở góc ψ = 00, quét trên máy nhiễu xạ có góc 2θ từ 0,20 đến 1600, 

tốc độ quét được duy trì ở 0,030/s trong quá trình đo. Kết quả đường nhiễu xạ cho thấy có 

nhiều đỉnh nhiễu xạ tương ứng với góc 2θ (Hình 6). Để thuận lợi cho công việc tính toán 

ứng suất thì đỉnh nhiễu xạ được chọn trong khoảng 820 ứng với mặt nhiễu xạ {211}.  

Dùng phương pháp nội suy hàm Gauss để xác định vị trí đỉnh của đường nhiễu xạ 

đo tại các góc Sin2ψ = 0; Sin2ψ = 0,05; Sin2ψ = 0,15; Sin2ψ = 0,25; Sin2ψ = 0,35 ứng với 

các chiều dày mạ crôm 9 μm, 30 μm, 61 μm và 93 μm. Từ kết quả đo trên máy nhiễu xạ 

tia x và sử dụng phần mềm OriginPro 8.5.1 để nội suy đường nhiễu xạ theo phương trình 

Gauss cho các chiều dày mạ crôm. 

 

 

 

 

 

 

 

 

 

 

 

    

              a) Chiều dày 9 μm    

 

     

        b) Chiều dày 30 μm 
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Hình 6. Đường nhiễu xạ của vật liệu crôm 
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         c) Chiều dày 61 μm 

 

   

                   d) Chiều dày 93 μm 

Hình 7. Nội suy đường cong Gauss cho lớp phủ crôm 

Hình 7 thể hiện đường nhiễu xạ cho lớp crôm và vị trí đỉnh nhiễu xạ tương ứng với 

góc 2θ được nội suy từ đường cong Gauss, khoảng cách mặt tinh thể trong các lớp phủ 

crôm được tính qua công thức Bragg tại công thức 1 và được trình bày trong Bảng 4. 

Bảng 4. Khoảng cách mặt tinh thể d và góc nhiễu xạ 2θmax 

9 μm 

Sin2 ψ 0 0,05 0,15 0,25 0,35 

2θmax 82,030 82,025 82,023 81,955 81,940 

d 1,1737 1,1738 1,17382 1,1746 1,1747 

30 

μm 

Sin2 ψ 0 0,05 0,15 0,25 0,35 

2θmax 82,010 81,998 81,972 81,966 81,940 

d 1,1738 1,1741 1,1744 1,1745 1,1748 

61 

μm 

Sin2 ψ 0 0,05 0,15 0,25 0,35 

2θmax 82,061 82,045 82,035 82,015 82,009 

d 1,1734 1,1736 1,1737 1,1739 1,1740 

93 

μm 

Sin2 ψ 0 0,05 0,15 0,25 0,35 

2θmax 81,919 81,913 81,907 81,899 81,88 

d 1,1750 1,1751 1,1752 1,1753 1,1756 

Từ dữ liệu trên, ứng suất được xác định theo công thức 6 và thể hiện trên Bảng 6 

Tính toán sai số ứng suất: 

Với dữ liệu đo nhiễu xạ tia x ứng với các giá trị Sin2 ψ từ 0 đến 0,35. Phần mềm 

OriginPro 8.5.1 được sử dụng để nội suy đường nhiễu xạ theo phương trình Gauss để xác 

định đỉnh và sai số đỉnh cho các chiều dày mạ crôm theo Bảng 5. 
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Bảng 5. Đỉnh nhiễu xạ và sai số đỉnh nhiễu xạ (σp) 

9 

μm 

Sin2 ψ 0 0,05 0,15 0,25 0,35 

Đỉnh nhiễu xạ (peak) 82,030 82,025 82,023 81,955 81,940 

Sai số đỉnh nhiễu xạ (σp) 0,00623 0,00475 0,00917 0,01447 0,01719 

30 

μm 

Sin2 ψ 0 0,05 0,15 0,25 0,35 

Đỉnh nhiễu xạ (peak) 82,010 81,998 81,972 81,966 81,940 

Sai số đỉnh nhiễu xạ (σp) 0,00687 0,00659 0,00845 0,01293 0,02089 

61 

μm 

Sin2 ψ 0 0,05 0,15 0,25 0,35 

Đỉnh nhiễu xạ (peak) 82,061 82,045 82,035 82,015 82,009 

Sai số đỉnh nhiễu xạ (σp) 0,00857 0,00913 0,00884 0,01436 0,0258 

93 

μm 

Sin2 ψ 0 0,05 0,15 0,25 0,35 

Đỉnh nhiễu xạ (peak) 81,919 81,913 81,907 81,899 81,88 

Sai số đỉnh nhiễu xạ (σp) 0,01049 0,01093 0,01739 0,02479 0,03408 

-Tính toán sai số ứng suất cho chiều dày mạ 10 μm: 

Áp dụng công thức 

 



= =
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Ta tính được A1 = - 1,951219512; A2 = - 1,341463415; A3 = - 0,12195122;  

A4 = 1,097560976; A5 = 2,317073171 

Vậy sai số của ứng suất: 

2 2

1

2 2 2 2 2 2 2 2 2 2

.

280,4113 ( 1,951 0,00623 ) ( 1,341 0,00475 ) ( 0,121 0,00917 ) (1,098 0,01447 ) (2,32 0,01719 )

12,63
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+
 (MPa) là hệ số ứng suất phụ thuộc vào vật liệu 

Trong đó: Môđun đàn hồi: E=271 GPa, hệ số possion: ν = 0,23, góc nhiễu xạ khi không 

chịu ứng suất: θ0= 81,70  

Từ đó 95% tin cậy của giá trị ứng suất được tính toán là: 

                 1.96 1.96 12,63 25s x  =  =  =  (MPa) 



TẠP CHÍ KHOA HỌC VÀ CÔNG NGHỆ - SỐ 33 - TRƯỜNG ĐẠI HỌC PHẠM VĂN ĐỒNG 

⚫ JOURNAL OF SCIENCE AND TECHNOLOGY ⚫    76 

Tương tự, ta tính toán sai số ứng suất cho các chiều dày còn lại. Kết quả thể hiện 

trên ở Bảng 6. 

Bảng 6. Bảng tổng hợp giá trị ứng suất dư các mẫu 

STT Chiều dày 

lớp phủ (µm) 

Ứng suất bề mặt 

lớp crômσ (MPa) 

Sai số ứng suất 

Δσ (MPa) 

1 9 620 ± 25 

2 30 431 ± 29 

3 61 319 ± 31 

4 93 228 ± 26 

Nhận xét: 

Kết quả đo ứng suất cho thấy, trong mạ crôm luôn tồn tại ứng suất dư kéo và vết 

nứt tế vi. Điều này được chứng minh là do quá trình phân hủy crôm hydrua trong quá 

trình kết tủa crôm gây co rút thể tích làm phát sinh ứng suất kéo và các vết nứt tế vi. Kết 

luận này là hoàn toàn phù hợp với các nghiên cứu [7, 8]. Sai số của ứng suất dư theo 

công thức được thành lập trên lớp crôm từ ± 25 đến ± 31 MPa. Kết quả này là phù hợp 

với nghiên cứu của Voorwald và các cộng sự khi đo ứng suất dư của lớp crôm sử dụng 

tia x với sai số Δσ = ± 20 MPa [8]. 

4.3. Xác định mật độ vết nứt tế vi của lớp mạ crôm 

Kính hiển vi quang học IM 300 - Euromex được sử dụng để khảo sát vết nứt của 

lớp phủ với các chiều dày khác nhau. Hình 8 thể hiệu mật độ vết nứt tế vi của lớp mạ 

crôm ứng với bốn chiều dày 9/30/61/93 μm.  Quy trình xác định mật độ vết nứt tế vi của 

lớp phủ được áp dụng được trình bày mục 3.2. Ảnh trắng đen 8 bit với phần mềm ImageJ 

được thể hiện trên Hình 9. Số điểm ảnh (pixel) của vết nứt và tổng số điểm ảnh của diện 

tích khảo sát được tính toán qua phần mềm ImageJ. Từ đó, mật độ vết nứt tế vi tương 

ứng với các chiều dày. 

  

a) Chiều dày 9 μm b) Chiều dày 30 μm 



 TẠP CHÍ KHOA HỌC VÀ CÔNG NGHỆ - SỐ 33 - TRƯỜNG ĐẠI HỌC PHẠM VĂN ĐỒNG 

 

                                                       ⚫ JOURNAL OF SCIENCE AND TECHNOLOGY ⚫    77 

  

c) Chiều dày 61 μm d) Chiều dày 93 μm 

Hình 8. Mật độ vết nứt tế vi ứng với các chiều dày lớp crôm 

 

  

a) Chiều dày 9 μm b) Chiều dày 30 μm 

  

c) Chiều dày 61 μm d) Chiều dày 93 μm 

Hình 9. Ảnh mật độ vết nứt tế vi chuyển thành ảnh trắng đen 8 bit 

Kết quả tính toán mật độ vết nứt tế vi được thể hiện trên Bảng 7.  
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Bảng 7. Mật độ vết nứt tế vi các mẫu 

STT 
Chiều dày 

lớp phủ (µm) 

Tổng số điểm 

ảnh đen-vết 

nứt (pixel) 

Tổng số điểm 

ảnh diện tích 

khảo sát (pixel) 

Mật độ vết 

nứt tế vi (%) 

1 9 14490 713838 2,03 

2 30 18555 715624 2,60 

3 61 26286 712460 3,69 

4 93 38428 712712 5,40 

Nhận xét: 

Kết quả cho thấy khi tăng chiều dày lớp mạ crôm, ứng suất kéo có xu hướng giảm 

và mật độ vết nứt tế vi có xu hướng tăng. Nguyên nhân sự co rút tinh thể crôm càng lớn 

khi chiều dày mạ tăng dẫn đến xuất hiện nhiều vết nứt tế vi và làm xả ứng suất nên ứng 

suất dư kéo giảm [5-8]. Cụ thể, đối với chiều dày 9 μm có ứng suất kéo là 620 MPa 

tương ứng với mật độ vết nứt tế vi là 2,03%; ứng suất kéo giảm đến 431 MPa (mật độ vết 

nứt tế vi là 2,6%) đối với chiều dày 30 μm; 319 MPa (mật độ vết nứt tế vi là 3,69%) ứng 

với 61 μm và là 228 MPa cho chiều dày 93 μm tương ứng với mật độ vết nứt tế vi là 

5,4%. Mật độ vết nứt tế vi tăng dần từ 2,03% đến 5,4% ứng với chiều dày 9 μm đến 93 

μm. Kết quả về mật độ vết nứt tế vi của lớp crôm được khảo sát theo phương pháp được 

xây dựng trong bài báo này là phù hợp với nghiên cứu của Vidal và các cộng sự [11]. 

Nhóm tác giả đánh giá mật độ vết nứt tế vi trung bình của lớp mạ crôm là 3,4% khi được 

khảo sát trên ảnh SEM.  

5. Kết luận 

Qua nghiên cứu, tác giả đã thực hiện xây dựng công thức đánh giá sai số khi tính 

sai số ứng suất cho lớp phủ nói chung và phương pháp mạ crôm nói riêng khi dùng nhiễu 

xạ tia X. Bên cạnh đó, phương pháp đánh giá mật độ vết nứt tế vi của lớp phủ thông qua 

phần mềm ImageJ được tác giả phát triển. Các phương pháp đề xuất đã được đánh giá 

qua thực nghiệm đối với lớp mạ crôm trên nền thép C45. Kết quả thực nghiệm cho thấy 

độ tương thích với các nghiên cứu đã công bố. Điều này cho thấy độ tin cậy của phương 

pháp đề xuất. 
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ENHANCING ACCURACY IN THE EVALUATION OF RESIDUAL STRESS 

AND MICROCRACK DENSITY IN COATINGS 

        Nguyen Vinh Phoi1 

ABSTRACT 

Currently, coating is one of the advanced technologies being studied for 

application in surface treatment technology. Methods for evaluating the properties of 

coatings are therefore receiving considerable research attention. In this paper, an error 

formula for measuring the residual stress of coatings using X-ray diffraction is 

developed. A method for assessing the microcrack density of coatings using image 

processing technology is also introduced. Experimental results show that the stress error 

in the coating is determined using a diffraction line interpolation method based on the 

Gaussian approach. The microcrack density is accurately evaluated through image 

processing technology. 

Keywords: Coatings, chromium plating, stress, microcrack density, X-ray. 
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